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ForexGridMaster Express Manual 
 

FGM Express MT4 Expert Advisor User Input Settings Guide updated January 27, 2015 
Copyright 2010-2015 ForexGridMaster.com. All rights reserved. EA robot Design by James King 

Development by Gendec Design (v2.4 to v3.01 and v5.1, Express, Advanced and Pro (the Master is back) 
 

The contents of this presentation are for educational purposes only and should not be considered as investment advice in 
any way. ForexGridMaster.com, its owners, staff, affiliates and or associates, are not liable for any loss or damage of any 
kind which may arise directly or indirectly from the trading or use of any of ForexGridMaster.com offerings, including 
ForexGridMaster and ForexTradeManager Expert Advisor robots and all related information and materials on or off the 
website. The Terms and Conditions for use of all materials related to ForexGridMaster and ForexTradeManager are available 
at http://forexgridmaster.com/agreement.php and also at http://forexgridmaster.com/terms.php.  
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Introduction to ForexGridMaster Express 
 
ForexGridMaster EA (Expert Advisor) Robot has been in development since 2005 to enable Traders to create and 
trade their own unlimited number of automatic trading system strategies as well as trade those created and shared by 
others. All FGM Express input settings and what they do are transparent and easily configured by Trader. FGM was 
designed for, but not limited to, developing mathematically based grid trading strategies that profit from price moving 
up or down or both ways simultaneously, including trend, counter-trend, range, scalping, news and or breakout 
trading, and portfolio trading. FGM is also very versatile for precision semi-automatic manual trading, especially 
stealth scalping. The new settings ChartEquity, LotSizeScaling (replaces LotSizePercent), MaxOrderPeriod and 
MaxOrderFrequency for protection from price spikes and also the new Normalization process using Conversion-pairs 
with Account-currency, mark the transition from ForexGridMaster v5.1 to FGM Express and FGM Advanced versions. 
Sample strategy results are posted on our Performance page, ForexGridMaster YouTube Channel and our FGM 
Forum. Back-testing Optimization Reports are posted and shared at FORO (FGM Optimization Reports Online) 
publicly or privately with viewing and download links for the preset strategy files created for and by those reports. 
 
ForexGridMaster, going beyond the normal limits of MetaTrader 4 developed by MetaQuotes, is programmed with 
Industrial Strength code by a Master developer (Gendec Design) and is very much on the leading edge of automated 
Forex trading. It truly is the Rolls Royce for creating automated Forex strategies, and especially for grid trading. 
 
Matching specific FGM Express strategies to the most appropriate brokers can make a big difference in the results 
achieved by Trader, especially when trading scalping strategies. I have traded at more than 20 carefully selected 
brokers since 2002 and the choices continue to evolve in favour of traders as brokers become more competitive, 
traders more aware, and regulatory agencies more watchful. Now it is the norm to expect low spreads (1 pip or less 
for eurusd), no or low commissions, no re-quotes, instant execution, no trade restrictions such as pending order 
distance from current price, tight stop losses, 1 to 30 ms latency from VPS to broker server, etc. These are important 
aspects to learn well, to take advantage of FGM, perhaps the best money making opportunity available today. 
 
ForexGridMaster Express is user friendly, and it is also a very sophisticated software program with many choices that 
requires time and practice for the user to comprehend and apply all or some of the possibilities. Be warned that all the 
settings and possible combinations of settings may trigger a lot of brain-storming and fun. Gamers, take note. 
 
Important ForexGridMaster Express User Guidelines                               TOC                              Settings 
 
1. After FGM Express is installed, the manuals for FGM Express, ForexTradeManager, Back-testing, Latency, and 
the purchase agreement, etc. can be found via the Start menu > All Programs > ForexGridMaster. The active EA 
robot files are in the MT4 active data folder (Top menu > File > Open Data Folder). View directory tree here. The MT4 
trading platform has to be closed and restarted for FGM to work. For help whenever needed go to our FGM Forum.  
 
2. Build - FGM Express is best traded on MT4 builds 670 to 765, the latest available as of January 27, 2015. 
  

http://forexgridmaster.com/
http://forexgridmaster.com/agreement.php
http://forexgridmaster.com/agreement.php
http://forexgridmaster.com/terms.php
http://www.forexgridmaster.com/performance.php
https://www.youtube.com/channel/UCo1a5rAQF1GCnPRoj9vVfyw
http://forexgridmaster.com/fgm-forum/phpBB3/index.php
http://forexgridmaster.com/fgm-forum/phpBB3/index.php
http://forexgridmaster.com/opt_reports.php
http://www.metaquotes.net/en
http://forexgridmaster.com/fgm-forum/phpBB3/index.php
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3. FGM Licensing - FGM Express Full-version is licensed to Trader’s account number and name, allowing up to 3 
real money accounts and 5 demo accounts. FGM Express Trial-version only works on demo accounts. License 
changes can be made when needed by logging into to your EAfactory account.                          Settings 
 
4. Account-currency - FGM can trade using any Account-currency… USD, EUR, GBP, JPY, CHF, AUD, etc. FGM 
also integrates Conversion-pair currency calculations (Normalization). This enables more accurate results when using 
different Account-currencies trading the same strategy and same currency pair on demo and real money accounts or 
in Strategy Tester. Metaquotes does not acknowledge this issue yet and consequently Strategy Tester results without 
Normalization can be inaccurate, very much so at times. For example, trading the AUDNZD using a USD Account-
currency, the NZDUSD is the Conversion-pair (ratio of Account-currency USD to the NZD Quote-currency). This 
means in Strategy Tester that M1 historical data must be loaded for NZDUSD as well as AUDNZD for the FGM 
Express Normalization to work and obtain the most accurate back-testing results. In Strategy Tester the NZDUSD 
price action is seen tracked on the bottom right of the chart. Same example, but on a real money account, the 
NZDUSD must also be listed in the Market Watch window so that FGM will integrate the NZDUSD Conversion-pair 
price action in real time as well. Trading the AUDNZD with NZD as the Account-currency, no conversion pair is 
needed. Trading the AUDNZD with AUD as the Account-currency, the Conversion-pair is the AUDNZD itself. 
 
5. Decimal places - FGM Express automatically detects whether the broker uses 2, 3, 4 or 5 decimal places for price 
quotes. So in any case, as an example, TakeProfitPips can be set to 17 pips regardless of whether the price quotes 
use 2, 3, 4 or 5 decimal places. In the case of the EURUSD as one example of 5th place decimal pricing, the 4th 
place decimal is the pip and the 5th a fraction of a pip called a point. If the EURUSD moves from 1.37010 to 1.37020 
then it has moved 1 pip or 10 points. If it moves from 1.37010 to 1.37011, then it has moved 1/10th of a pip or 1 point. 
For currencies with 3 decimal places, such as the USDJPY, if it moves from 95.700 to 95.710, then it has moved 1 pip 
or 10 points, and if from 95.700 to 95.701, then it has moved 1/10th of a pip or 1 point.  
 
6. ECN - We highly recommend MT4 to ECN brokers. I am an Introducing Broker to IC Markets in Australia, my 
referral link ... http://icmarkets.com/?camp=1085, a win win situation for us both at no cost to you. They have the best 
spreads, execution, latency and no trade restrictions. They also have their servers in London and New York directly 
connected by special high speed connection in the same data center to the best VPS provider, Commercial Network 
Services, my referral link … (https://cp.commercialnetworkservices.net/aff.php?aff=152 (more data center info HERE).                 
 
7. Settings changes - When starting a new strategy or make changes to an existing strategy (except settings that 
can be changed on-the-fly), remember the rule New Strategy = New Chart.  Removing FGM from an old chart is 
ULTRA important because it clears the Globals associated with that Chart Strategy. To close associated trades, use 
the MT4 "One-Click Trading Mode" for fast delete of trades or perhaps ForexTradeManager if many trade orders.         
 
8. Time-frames - FGM Express strategies are not time-frame dependent, meaning that any FGM strategy can be 
traded on any time frame and the only difference will be how well the trading action can be viewed. My routine is to 
always keep ForexGridMaster trading on the M1 time-frame only and I open an extra chart or two of the same 
currency pair on the same account to view other time-frames and indicators. The pending orders and open trades will 
also display on extra charts. The time-frame can be changed on-the-fly on the same chart that FGM trades, but doing 
so will effect the display size of the CloseRun bars due to MT4 object display limitations.              Settings 
 
9. Closing orders - Whenever many open and or pending orders are triggered to close at the same time, by 
CloseRun settings and or ForexTradeManager, it takes time for the open trades and pending orders to all close. Price 
is moving so results will not be perfectly accurate. In normal market conditions, the difference is relatively small if any. 
 
10. Many orders - The more open trades and pending orders on the trading charts, the more chances of execution 
delays, especially if the latency of trade execution is more than 50 ms. Also not all brokers are the same. The amount 
of technology involved, the broker and their server, their MT4 environment, the computer that FGM Express trades 
from, at home, office or VPS, bank feeds to the broker, the Internet, etc. is complicated and relatively in its infancy. 
MT4 executes only one line of code at a time per chart, and altho rare now, glitches can happen and starting out, it is 
important to keep a watchful eye on the MT4 platform as it trades FGM strategies, at least until it’s known that all will 
work reliably. We very strongly recommend that all FGM strategies be traded on a demo account first and also back-
test and forward-test them on Strategy Tester on at least 3 years of M1 data, or tick data, for as long as it takes to 
become familiar and confident with how all the FGM Express input settings work for those strategies. Start small 
when trading a real money account in the beginning. MT4 brokers are not equal and different MT4 broker platforms 
may produce different results for different reasons. However FGM Express programming is the best Industrial 
Strength quality and is capable of trading working strategies very reliably for an indefinite period of time. 
 

https://my.eafactory.com/ForexGridMaster
http://icmarkets.com/?camp=1085
https://cp.commercialnetworkservices.net/aff.php?aff=152
http://www.icmarkets.com/forex-trading-platform/trading-servers/


11. FGM EA smiley face ---    --- When ForexGridMaster is trading and all is well, a small smiley face icon can be 
seen positioned at the top right of the currency pair chart window. Click on that smiley face to open FGM’s  properties 
window. Sometimes however, the info printed on the chart just below the smiley face is selected by mistake and FGM 
will not be opened to its properties window, especially if a larger font size has been chosen for the chart comments 
and stats display. Otherwise, just right-click in any clear area on the chart display and choose “Expert Advisors…” and 
then “Properties…”. If ever there is an emergency situation when FGM cannot be accessed to change its property 
settings or cannot be removed for whatever reason, click the “Expert Advisors” button on the tool bar above to disable 
it, or simply close the chart window to remove FGM. If necessary, any open trades and pending orders will then need 
to be closed manually or by using ForexTradeManager. The smiley face turns red when FGM is active and the 
properties window is not accessible while it is red.           Settings 
 
12. Preset “.set” strategy files - When creating strategies for FGM Express using the input settings described 
below, they can be saved as preset files in the “(MT4 Data Folder)\MQL4\Presets” default directory (or wherever 
desired), so that whenever ready to trade that strategy, ForexGridMaster can be opened on a chart and then “Load” 
the preset file from the “Inputs” tab. FGM preset files can also be saved and shared with others. We name preset files 
so that we can recognize what the strategy is and what some of the most important settings values are. FGM default 
strategy as an example, “audnzd_bsct5-s0.05_lsp0.015-ip16.2_tp21_m990-3_crppbts0.3-ts0.0001_ce25-us100k.set”, 
is a BuySell CounterTrend strategy to trade the audnzd pair with GridSpacing=5 pips, GridSpacingStep=0.05 pips, 
LotSize(Proportional)=0.015, LotSizeIncreasePercent=16.2, TakeProfitPips=21, CR_ProfitPercentBeforeTS=0.3 with 
CR_TrailStopPercent=0.0001 and works best trading at least $25,000 ChartEquity of US $100,000 Account-currency. 
To trade smaller Account balances best to find a broker offering Cent accounts with minimum lot-sizes being nano-
lots ($100 in trade) and pico-lots ($10 in trade).  XM offers Cent accounts, trading nanolots or pico lots. 
 
13. Leverage - Some brokers will allow as much as 1:500 leverage or more on their accounts. This means that FGM 
can trade a full standard lot of $100,000 using only $200 on margin, which is excellent for FGM, especially when 
trading for high profit. Most grid trading strategies need lots of margin for flexibility, especially for Portfolio trading. The 
leverage on the account that FGM is trading can be seen in the Experts tab entries, usually a line or two after FGM 
has been initialized.  High leverage can be dangerous if Trader doesn’t know what she is doing. 
 
14. Sharing strategies - Preset “.set” files can be shared with other traders directly, on our forum or online using 
FORO. Our goal is to have many traders creating, back-testing and optimizing reliable winning strategies for all. 
Please visit and participate in our forum to help develop many profitable and reliable FGM strategies.      Settings 
 
15. Back-testing - FGM should always use M1 data or Tick data for back-testing as no other time-frame will work 
properly. See the back-testing manual included with FGM purchase for more information. In History Center (Top 
menu > Tools > History Center > on the left, select currency pair > select 1 Minute (M1) > click the “Download” button 
very bottom left > to download M1 data from MetaQuotes (MT4 program developer). Proper back-testing saves tons 
of time and grief and can be fun and exciting, much like playing a great video game. Trading a real money account 
without having done any back-testing is like running towards the edge of a mile high cliff with a blindfold on. 
Downloading Metaquotes data is not so great for some currency pairs. We are now using AUDNZD M1 data from 
http://www.histdata.com/download-free-forex-data/?/metatrader/1-minute-bar-quotes, as the gaps are fewer. 
 
16. MT5 - Here's an excellent letter by Daniel Fernandez (writer for CurrencyMag) to MetaQuotes that gives a good 
idea of where MetaTrader is at presently (as of July 15-14). Many experienced traders and developers are very 
frustrated with different aspects of MT4 and MT5 including myself ... http://mechanicalforex.com/2013/05/an-open-
letter-to-metaquotes.html. We agree with all of Daniel’s comments except we think things have gotten better from 
build 745 onwards. We will monitor MetaTrader’s progress closely to see if when to create any MT5 versions of FGM.  
 
17. JForex - The JForex platform programmed in JAVA has built a solid reputation and we may eventually create 
JForex versions of ForexGridMaster which can be traded at DukasCopy and other brokers offering JForex as well. 
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ForexGridMaster Express Expert Advisor Input Settings List                      TOC                      Settings   .                 
 
These 48 Trader input settings (+ more drop down menu sub-choices) are linked to their descriptions further below. 
The default settings values match the FGM Express on board audnzd default strategy, for demonstration purposes 
only. Drag and drop FGM from the Navigator Experts directory on a currency pair chart and its properties window will 
open where any of the values of the settings listed below can be viewed and or changed. Click the OK button to start 
FGM Express trading its default strategy (if no settings changes are made first) beginning with Run 1 on the next tick.                
 
 

http://clicks.pipaffiliates.com/afs/come.php?id=59&cid=47651&ctgid=17&atype=1
http://forexgridmaster.com/fgm-forum/phpBB3/
http://forexgridmaster.com/opt_reports.php
http://www.histdata.com/download-free-forex-data/?/metatrader/1-minute-bar-quotes
http://mechanicalforex.com/2013/05/an-open-letter-to-metaquotes.html
http://mechanicalforex.com/2013/05/an-open-letter-to-metaquotes.html
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Copyright 2010 to 2015. ForexGridMaster.com. All rights reserved. Contact - fgm@forexgridmaster.com 
 
1. EANumber=528 
2. SetFileName=bsct5-s0.05_lsp0.015-ip16.2_ tp21 
3. SetFileInfo=m990-3_crppbts0.3_ce25-us100k 
4. ChartEquity=25000 
5. Main_Grid=Fixed_Center 
 
Grid_General_Inputs 
6. GridOrderTypes=Buy_Sell 
7. TrendDirection=Counter_Trend 
8. GridSpacing=5 
9.  MaxPendingBuyOrders=1 
10. MaxPendingSellOrders=1 
11. MaxOpenBuyTrades=60 
12. MaxOpenSellTrades=60 
13. CenterZonePips=0 
14. GridOrderReplacement=true 
15. OpenAtCurrentPrice=Not_Used 
 
Grid_Order_Inputs 
16. LotSize=0.015 
17. LotSize_Scaling=Proportional 
18. TakeProfitPips=21 
19. StopLossPips=0 
20. BreakEvenStop=false 
21. ProfitPipsBeforeBES=0 
22. BreakEvenStopPlusPips=0 
23. ProfitPipsBeforeTS=0 
24. TrailStopPips=0 
25. MaxOrderPeriod=990 
26. MaxOrderFrequency=3 
 
Important - Back-test and walk-forward-test FGM 
strategies extensively in Strategy Tester over at  
least a 3 year historical period to fully understand  
what the settings and their combinations do exactly. 
Please do not under-estimate how important these  
steps really are. Be the master of your destiny.  
 

Grid_FixedCenter_Inputs 
27. GridSpacingStep=0.05 
28. LotSizeIncreaseAmount=0.0 
29. LotSizeIncreasePercent=16.2 
30. LotSizeIncreaseFibo=false 
31. TakeProfitPipsStep=0.0 
 
Grid_MovingCenter_Inputs 
32. BuySellOverlap=false 
33. BuySellOffsetPips=0 
 
CloseRun_Inputs 
34. CR_AutoRestart=true 
35. CR_ProfitPercent=0.0 
36. CR_LossPercent=70 
37. CR_ProfitPercentBeforeTS=0.3 
38. CR_TrailStopPercent=0.0001 
39. CR_ProfitPips=0 
40. CR_LossPips=0 
41. CR_ProfitMoneyBeforeTS=0.0 
42. CR_TrailStopMoney=0.0 
43. CR_PriceMaximum=0.0 
44. CR_PriceMinimum=0.0 
45. CR_PriceTrailStopPips=0 
46. CR_LossStop=true 
47. CR_IncludeClosedTradesNet=true 
 
Close_Now_Inputs 
48. CloseOrdersNow=None 
 
Important - There are more options in the  
FGM_Express.prf file to change how and what  
FGM displays on the chart, to set alerts, and more.  
 
View the FGM Advanced Manual to see the differences 
between FGM Express and FGM Advanced, Hedge (or a 
second grid) system and other settings. 

Important - Some of the above 48 settings can be changed on-the-fly, meaning that the FGM properties window can 
be opened while FGM is trading, and some input settings changed without removing the EA first. Settings that can be 
changed on-the-fly are generally those that will not change the basic trading strategy.  
 
ForexGridMaster Express Input Settings Descriptions                       TOC                   Settings 
 
      The default values of all settings listed below combine as the default FGM BuySell CounterTrend strategy that is 
optimized to trade the AUDNZD. It may work for other currency pairs with similar price action and some adjustment of 
settings’ values, but in any case, this default strategy is for demonstration purposes only. Back-test and walk-forward 
test all FGM strategies over at least a 3 year historical period to gain a thorough understanding of how the strategy 
works and what the risks are before trading real money. See our FGM Back-testing manual and good to be thorough.                  
      View how FGM Express trades at the ForexGridMaster YouTube Channel, where I back-test the previous default 
strategy live for 1 year up until August 30, 2014, explaining trading activity as it trades. View here, stats of a 56 month 
back-test trading the same strategy. Trader can easily back-test the FGM default strategy too. In the Strategy Tester 
EA Properties window on the “Testing“ tab, as one example, set “Initial deposit: 100,000 USD“ to enable Portfolio 
trading using ChartEquity=25000 with FGM trading on more than one chart or simply provide more margin buffer. Still 
on “Testing“ tab, set “Positions: Long & Short“, “Optimized parameter: Balance“, and un-check “Genetic algorithm“. 
On the “Optimization“ tab leave all choices un-checked. Those steps enable all results to be shown, to learn from 
negative results as well as positive ones. In the MT4 History Center (top menu > Tools > History Center) we advise 

http://forexgridmaster.com/
mailto:fgm@forexgridmaster.com
http://forexgridmaster.com/ForexGridMaster_Advanced_Manual.pdf
https://www.youtube.com/channel/UCo1a5rAQF1GCnPRoj9vVfyw
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that Trader take the time to import AUDNZD and NZDUSD M1 data from http://www.histdata.com/download-free-
forex-data/?/metatrader/1-minute-bar-quotes, as the M1 AUDNZD and NZDUSD data downloaded from Metaquotes 
is not complete. We highly recommend those steps be learned from first, before customizing strategies to a particular 
trading style, risk tolerance, and goals.  Portfolio trading can be setup by trading a second instance (or more) of FGM 
on a second chart (or more) and dividing Account deposit into sub-accounts using the ChartEquity setting.        ..  
 
1. EANumber=528 - (EAN) This input enables each instance of FGM Express to keep track of its own trades and 
calculations separate from other instances of FGM, other EAs, and also any trades placed manually, on the same 
currency pair or different currency pairs in the same trading account. Each FGM must run by itself on its own chart 
and its EANumber must be uniquely different from each EANumber used by other EAs on other charts. 
ForexGridMaster’s input settings affect only trade orders associated with the EANumber of that FGM instance. This is 
different from ForexTradeManager whose settings can affect all trade orders placed manually and or by other EAs. It 
doesn’t matter what EANumber is chosen except that the number is limited to 9 digits.  When finished with a strategy 
and switching to a new strategy, remove FGM from the chart first, and when starting again with a new strategy, 
change either the EANumber or delete chart objects so that the Current Run Stats on the chart are reset properly for 
a new beginning, and also the robot will not be influenced by any historical trading activity that occurred previously. 
This setting cannot be changed on-the-fly.     Settings 
 
2. SetFileName=e_audnzd_bsct5-s0.05_lsp0.015-ip16.2_tp21 - (SFN) The values set here are displayed on the chart 
that FGM is trading in the MT4 trading platform, top right. Anything can be typed here, but most useful is a name that 
indicates the most important settings values of the strategy. This setting and the next setting describe the current 
FGM Express on board default strategy for trading the AUDNZD. The value “bsct5-s0.05” indicates the strategy is a 
BuySell, CounterTrend, FixedCenter strategy with GridSpacing=5 pips with GridSpacingStep=0.05 pips. The value 
“lsp0.015-ip16.2” indicates LotSize=0.015 with LotSizeScaling=Proportional and LotSizeIncreasePercent=16.2. The 
value “tp21” indicates TakeProfitPips=21 pips. This setting can be changed on-the-fly.             
 
3. SetFileInfo=m990-3_crppbts0.3-ts0.0001_ce25-us100k - (SFI) Anything can be typed here and it displays on the 
chart beneath SetFileName mentioned above. This is more info about the strategy. The value “m990-3” indicates 
MaxOrderPeriod=990 and MaxOrderFrequency=3, so 3 open trade orders are the max allowed during the 
MaxOrderPeriod of 990 seconds. The value “crppbts0.3-ts0.0001” indicates CR_ProfitPercentBeforeTS=0.3 and 
CR_TrailStopPercent=0.0001. The value “ce25-us100k” indicates that trading account equity is $100,000 US and that  
ChartEquity=25 ($25,000 US) is traded.  (CR_ indicates a CloseRun setting). This setting can be changed on-the-fly.               
 
4. ChartEquity=25000 - (CE) When set to default 0.0, total account equity will be traded. When set to a money value, 
FGM trades only the value set. For example, if account equity is $100,000 and ChartEquity=25000, then FGM trades 
only $25,000. If CR_ProfitPercent=10 and that target is reached, a CloseRun is triggered and Run 1 closes all trade 
orders to capture the $2500 net profit and ChartEquity increases by 10% and then Run 2 starts with $27,500 being 
traded. In this example, 4 FGMs could be trading simultaneously, each trading $25,000 on its own chart. Also, total 
account equity can be traded on one chart and part equity on others. This is another and perhaps better way for 
certain strategies, to have a main account divided up into sub-accounts. This setting cannot be changed on-the-fly. 
 
5. Main_Grid=Fixed_Center or Moving_Center - (MGFC or MGMC) When Main_Grid=Fixed_Center, the FixedCenter 
will be current market bid price when FGM initiates Run 1. However if OpenAtCurrentPrice is enabled, then the 
FixedCenter will be half of the GridSpacing pips value away from the price that the buy or sell trade opened at, and 
exactly between the first buy and sell slot positions in a BuySell Grid. FixedCenter will remain at the same price for 
the duration of the Run, and the rest of the grid will develop based on that FixedCenter price. For Run 2 and follow-up 
Runs from there, FixedCenter will be determined as it was in Run 1. The Grid_FixedCenter_Inputs section settings 
can be used to modify FixedCenter Grid strategies.  
     When Main_Grid=Moving_Center - (MGMC) The initial MovingCenter price will be the current market bid price. 
The rest of the grid will develop based on that initial MovingCenter price, and MovingCenter price continues moving.      
     Because some brokers do not allow pending orders to be placed within 5-20 pips (more or less) of market price, 
depending on GridSpacing and chosen currency pair, the initial grid position slots next to Grid center may not be filled 
with pending orders until current price has moved away far enough to allow it. In the meantime, grid slots further out 
from Grid center are filled when and where possible according to the already established initial Grid center price and 
other input settings choices. 
     A MovingCenter will change to always be the current moving market bid price when trading either a Buy or a Sell 
grid, or a BuySell grid combined with BuySellOverlap=true and or a set BuySellOffsetPips value. However, when 
trading a BuySell grid and BuySellOverlap=false, then the MovingCenter will center itself and remain between the buy 
and sell orders and will move as needed to always be between the buy and sell orders. Buy and sell pending orders 

http://www.histdata.com/download-free-forex-data/?/metatrader/1-minute-bar-quotes
http://www.histdata.com/download-free-forex-data/?/metatrader/1-minute-bar-quotes
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will be placed as close as possible to the MovingCenter price according to GridSpacing and or CenterZonePips 
settings. See examples immediately below. Main_Grid setting cannot be changed on-the-fly.  
 
MainGrid FixedCenter and MovingCenter                                     TOC                               Settings 
  
      Trading a Grid FixedCenter BuySell strategy, Buy and Sell pending orders are kept separated from each other, 
buys on one side of FixedCenter price and sells on the other, no overlap allowed. As an example, when FGM trades a 
BuySell Trend grid strategy, only pending Buy stop orders can be placed above FixedCenter price and only pending 
Sell stop orders can be placed below. If FGM trades a Buy Trend HalfGrid as another example, then only pending 
Buy stop orders can be placed above FixedCenter price. If trading a Buy CounterTrend HalfGrid strategy, then only 
pending Buy limit orders can be placed below FixedCenter price. 
      Trading a Grid MovingCenter strategy, Run 1 starts at current bid price, but having a MovingCenter it will always 
move as price changes for the duration of Run 1. For Run 2, the starting MovingCenter will again be the immediate 
market bid price after Run 1 closes. When CR_AutoRestart=true, follow-up Runs will continue the same way.        
 
Grid_General_Inputs - These settings are used to create the main infrastructure of the Grid. 
 
6. GridOrderTypes=Buy_Sell or Buy_Full or Sell_Full or Buy_Half or Sell_Half - (BS or BF or SF or BH or SH) This 
input determines whether the trade orders placed by FGM Express are either all buy orders, all sell orders, or both 
buy and sell orders, and also whether they use either a HalfGrid or FullGrid of orders. As an example, choosing the 
default BuySell, and deciding to trade a Trend grid of orders to capture profit in the direction of the price trend, then 
buy stop orders will be placed above grid center and sell stop orders below. If BuySell is chosen and trading a 
CounterTrend grid of orders is desired, then buy limit orders will be placed below grid center and sell limit orders 
above. This setting cannot be changed on-the-fly. 
     When set to Buy_Full or Sell_Full, grid orders will be placed equally divided on both sides of grid center, or one 
side only when set to Buy_Half or Sell_Half. BuySell grids automatically trade 2 HalfGrids because a HalfGrid of buy 
orders with a HalfGrid of sell orders are being traded. This setting cannot be changed on-the-fly.                               .                
     Here are some basic examples …   

1. Trade a Buy Trend grid to profit on price that is trending upwards. Choose FullGrid which will place pending 
buy stop orders above either a Moving or FixedCenter price, and pending buy limit orders below, choose 
HalfGrid which will place pending buy stop orders above a Moving or FixedCenter price, but no buy limits 
below. Trend trading HalfGrids in one direction only will lessen the number of accumulating open negative 
trades due to long price runs or spikes in the opposite direction of the trend. Depending on GridSpacing and 
how strong the trending is, 30% more or less losing trades are opened by retracements opening buy stop 
pending orders that are following the price downwards from above.  

2. Trade a Buy CounterTrend Half grid when expecting price to drop and turn back up. This will place a HalfGrid 
of pending buy limit orders below either a Moving or FixedCenter, but no buy stops above. 

3. Trade a BuySell CounterTrend grid on price that is ranging.  When trade a BuySell strategy it automatically 
trades 2 HalfGrids, placing pending sell limit orders above either a Moving or FixedCenter price, and pending 
buy limit orders below either a Moving or FixedCenter price.       Settings 

 
7. TrendDirection=CounterTrend or Trend - (CT or T) This input determines whether the Grid of orders traded will be 
a Trend or a CounterTrend grid strategy. A Trend grid places buy stops above grid center (Buy Trend), or sell stops 
below grid center (Sell Trend) or both (BuySell Trend). A CounterTrend strategy places buy limits below grid center 
(Buy CounterTrend), or sell limits above grid center (Sell CounterTrend) or both (BuySell CounterTrend). This setting 
cannot be changed on-the-fly. 
 
8. GridSpacing=5 - (GS) This input determines the distance in pips from each trade order grid slot to the next trade 
order grid slot of the same type (buys or sells) in the trading grid. If the CenterZonePips setting is used then the first 
pending orders start at the exact edge of the CenterZone and GridSpacing applies from there. The GridSpacing can 
be increased from one grid slot to the next going out from grid center by using the setting GridSpacingStep.  
This setting cannot be changed on-the-fly.                                                                          
 
9. MaxPendingBuyOrders=1 - (MPBO) This input determines at grid start the maximum number of pending buy limit 
and or buy stop orders permitted at any one time. If either or both MaxOpenBuyTrades and MaxOpenSellTrades 
below are set to a number other than the default 0, then MaxOpenBuyTrades and MaxOpenSellTrades will determine 
the limit of open trade slots allowed, and the number of pending orders will be controlled accordingly, meaning that 
MaxPendingBuyOrders cannot be set to a higher value than what is set for MaxOpenBuyTrades. If the number of 
open buy or sell trades reaches their limit, but then decreases (one or more open trades close), then FGM will resume 



FGM_Express (January 27, 2015)                                                                                                              Page 7 of 19                    

opening pending orders to match. FGM also limits total number of open pending orders to a maximum of 100. Some 
brokers may not allow that many. This setting can be changed on-the-fly to a higher value but not lower. 
 
10. MaxPendingSellOrders=1 - (MPSO) This operates exactly like buys above but applies to pending sell orders. 
 
11. MaxOpenBuyTrades=60 - (MOBT) When set to a number value, this input limits the number of open buy trade 
grid slots at any one time to that number. Manual trades or other EAs with a unique EANumber can be traded on the 
same currency pair and or other pairs on other charts on the same account, without them being affected by this 
setting. Most brokers limit the total number of orders placed in an account and some don’t. This setting can be 
changed on-the-fly when Main_Grid=Moving_Center but not when Main_Grid=Fixed_Center. When trading a 
FixedCenter grid and MaxOpenBuyTrades=20 for example, then the total number of Grid buy slots (grid positions) 
that can be occupied by buy orders on the Grid buy side is fixed at 20. Any trade orders occupying any of those 20 
positions can be opened, closed and replaced within a Run according to values set for other FGM inputs.      Settings 
 
12. MaxOpenSellTrades=60 - (MOST) This operates exactly as the buy orders above but applies to sell orders. 
 
13. CenterZonePips=0 - (CZP) When set to the default 0, this input is ignored.  When set to a number of whole pips 
greater than 0, then a MovingCenter or FixedCenter CenterZone, the pips depth of the value set, is created at and 
centered by Grid center. This CenterZone separates the placement of buy and sell orders, by the set value. For 
example, if CenterZonePips=30, then no Grid orders (pending or open) can occupy a slot inside that 30 pip 
CenterZone. If a MovingCenter strategy is traded, then the CenterZone can move as the position of the buys and 
sells move, however no Grid orders (open or pending) can occupy at the time of placement, a position within the 
CenterZone no matter where it is. When trading a HalfGrid, say a Buy Trend strategy, then the CenterZone space is 
only half of what CenterZonePips is set to. This setting cannot be changed on-the-fly. 
     When trading a MovingCenter strategy, the CenterZone moves in the direction of price and closing orders, within 
the current Run, and will remain between the buy and sell orders and will move as needed to always be between the 
buy and sell orders. However, when trading a FixedCenter strategy, then the CenterZone will remain fixed in place for 
the duration of the Run, keeping buys and sells separated by the value set. When trading a BuySell strategy and 
BuySellOverlap=true, then CenterZonePips=0 must be set to disable the input. CenterZonePips cannot be changed 
on-the-fly. Here are examples of how the CenterZone works with a FixedCenter or MovingCenter. 
 
a. FixedCenter --- Main_Grid=Fixed_Center, TrendDirection=Trend, GridSpacing=15,  
                               CenterZonePips=100, TakeProfitPips=35, MaxPendingBuyOrders=2. Looks like this … 
 
------- buy 2 stop ------- at 1.3115 
       GridOrderSpacing=15 
------- buy 1 stop ------- at 1.3100 
 
       CenterZonePips=100 --- Remains fixed in place until the Run closes. 
 
------- sell 1 stop ------- at 1.3000 
       GridOrderSpacing=15                                                                                                           Settings 
------- sell 2 stop ------- at 1.2985 
 
In the above example the CenterZone is fixed between 1.3000 and 1.3100 within the current Run. So if  
price moves down as an example, and sell 1 is opened at 1.3000 and then closed at 1.2965 by reaching its 
TakeProfitPips=35, the CenterZonePips=100 will simply remain from 1.3000 to 1.3100 until the Run closes. 
     
b. MovingCenter --- Main_Grid=Moving_Center, TrendDirection=Trend, GridOrderSpacing=15,                
                                  MaxPendingBuyOrders=2, MaxPendingSellOrders=2, MaxOpenBuyTrades=5,                   
                                  MaxOpenSellTrades=5, CenterZonePips=100, TakeProfitPips=35. Looks like this … 
 
------- buy 2 stop ------- at 1.3115 
       GridOrderSpacing=15 
------- buy 1 stop ------- at 1.3100 
       CenterZonePips=100 --- Initial CenterZone placement which will move up or down as buys and sells move. 
 
------- sell 1 stop ------- at 1.3000  
       GridOrderSpacing=15                                                                                                           Settings 
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------- sell 2 stop ------- at 1.2985 
 
When price moves down to 1.2965, then the Grid will then look like this … 
 
------- buy 2 stop ------- at 1.3100 (moved down from 1.3115 when buy 1 stop moved down) 
       GridOrderSpacing=15  
------- buy 1 stop ------- at 1.3085 (moved down from 1.3100 when sell 1 closed) 
 
      CenterZonePips=100 --- moved down 15 pips  
 
------- sell 2 open ------- at 1.2985 (opened when price moved down)    
       GridOrderSpacing=15  
------- sell 3 open ------- at 1.2970 (opened when price moved down) 
       GridOrderSpacing=15 --- sell 1 closed at 1.2965 (opened at 1.3000 and TakeProfitPips=35 reached)   
------- sell 4 stop -------- at 1.2955 (placed when sell 2 opened) 
       GridOrderSpacing=15 
------- sell 5 stop -------- at 1.2940 (placed when sell 3 opened) 
 
If price then moves all the way up from 1.2965 to say 1.3110, then the Grid will now look like this …  
 
------- buy 4 stop ------- at 1.3130 (placed when buy 2 opened) 
       GridOrderSpacing=15 
------- buy 3 stop ------- at 1.3115 (placed when buy 1 opened) 
       GridOrderSpacing=15 
------- buy 2 open ------ at 1.3100 (opened when price moved up here) 
       GridOrderSpacing=15  
------- buy 1 open ------ at 1.3085 (opened when price moved up here) 
 
      CenterZonePips=100 --- remains in same place                                                                 Settings 
 
------- sell 2 open ------- at 1.2985 (2nd sell opened that did not reach take profit) 
       GridOrderSpacing=15 
------- sell 3 open ------- at 1.2970 (was already open) 
       GridOrderSpacing=15 
------- sell 4 stop -------- at 1.2955 (placed when sell 2 opened) 
       GridOrderSpacing=15 
------- sell 5 stop -------- at 1.2940 (placed when sell 3 opened) 
 
If price then moves up more from 1.3110 to say 1.3130, then the Grid will now look like this … 
 
------- buy 5 stop -------- at 1.3145 (placed when buy 3 opened) 
       GridOrderSpacing=15 
------- buy 4 open -------- at 1.3130 (opened when price moved up here) 
       GridOrderSpacing=15 --- buy 1 closed at 1.3120 (opened at 1.3085 and TakeProfitPips=35 reached) 
------- buy 3 open ------- at 1.3115 (opened when price moved up here) 
       GridOrderSpacing=15 
------- buy 2 open ------- at 1.3100 (was already open)                              
 
       CenterZonePips=100 --- moved back up 15 pips                                                              Settings 
 
------- sell 4 stop ------- at 1.3000 (moved up when buy 1 closed and CenterZone moved up) 
       GridOrderSpacing=15\\ 
------- sell 2 open ------ at 1.2985 (sell opened that did not reach take profit ) 
       GridOrderSpacing=15 
------- sell 3 open ------ at 1.2970  (was already open)  
       GridOrderSpacing=15 
------- sell 5 stop ------- at 1.2955 (moved up when CenterZone moved up)      
 
 



14. GridOrderReplacement=true - (GOR) If true then when a Grid order has closed it will be replaced if and when 
price returns to that same Grid slot within the same grid Run. If false then each Grid order within a grid Run will only 
open once in the same Grid slot. This presently only applies to FixedCenter grids only. In MovingCenter grids 
GridOrderReplacement=false will not work. This setting can be changed on-the-fly.       Settings 
 
15. OpenAtCurrentPrice=Buy_Order or Sell_Order or Not_Used - (OACPB or OACPS or OACPN) When set to 
Not_Used, then this setting is ignored. When set to Buy_Order or Sell_Order, then either a buy or sell order is opened  
immediately at current price when FGM Express is initiated and then all other pending grid orders placed during the 
Run are adjusted to that price position for the Grid chosen. In other words, the immediate opened trade is part of the 
Grid being traded, and therefore determines where the GridSpacing starts from. When CenterZonePips=20, for 
example, and a buy is opened at 1.3000 and a BuySell Trend grid is trading, then the CenterZone is from 1.3000 to 
1.2980 and the grid operates from there as it does normally, the first pending sell order slot being set at 1.2980.  
 
Grid_Order_Inputs - Apply to individual orders. If MainGrid=Fixed_Center, can be modified by FixedCenter 
settings in the next section.       Settings 
 
16. LotSize=0.015 - (LS) This input sets the lot-size value for individual buy and or sell trade orders that FGM places 
during a GridRun. Most brokers allow a minimum lot-size of 0.01 which is 1/100th of the standard $100,000 lot-size, 
or $1,000 in trade (using USD as example) and so for FGM, 0.01, a micro lot, is the minimum LotSize value that can 
be set. Some brokers set their minimum lot-size 10 times higher, to 0.10 ($10,000, a mini lot) in which case FGM will 
display a message that this input needs to be reset to LotSize=0.10 before FGM can continue. 
     Some brokers also offer Mini Accounts with minimum lot-size of 0.01 which is 1/100th of the Mini Account lot size 
of $10,000, or $100 in trade, a nano lot. Some brokers also offer Micro Accounts with minimum lot-size of 0.01 which 
is 1/100th of the Micro Account lot size of $1,000, or $10 in trade, a pico lot.  
     The LotSize set for trade orders at the beginning of a GridRun, can remain fixed for all trade orders within the Run 
and all follow-up Runs, or it can be modified from Run to Run by the next setting LotSize_Scaling set to either 
Constant or Proportional. LotSize can also be automatically increased from trade order slot to trade order slot going 
out from grid center during a Run by using one of these Grid_FixedCenter_Inputs … LotSizeIncreaseAmount or 
LotSizeIncreasePercent or LotSizeIncreaseFibo. LotSize cannot be changed on-the-fly.  
       Important: Whatever value LotSize is set to, if Account-currency is not the same as Quote-currency, then there 
may be a lot-size adjustment made according to its Conversion-pair current price. As an example, set LotSize=0.06 
and the trade order size may be placed at 0.07. If Account-
currency is the USD and the AUDNZD (NZD the Quote-
currency) is being traded, then the current price of the 
Conversion-pair NZDUSD is taken into account and lot-size 
adjusted immediately at the start of Run 1, and it continues to 
be adjusted at the start of each follow-up Run according to 
how the price of NZDUSD has changed. The Conversion-pair (NZDUSD in this case) must be in the Market watch 
window as well so that current Conversion-pair price is tracked. Not all currency pairs and Account-currencies are 
supported yet. If something similar to the above right image is seen on the right in the lower right of the chart window, 
then it shows that what is trading is supported.  When back-testing in Strategy Tester, Conversion-pair M1 data must 
be downloaded or imported into History Center, NZDUSD in this case. If not there, check Experts log for message.                 
. 
17. LotSize_Scaling=Proportional or Constant - (LSSP or LSSC) When set to the default Proportional, the LotSize 
value set when initiating FGM into trade for Run 1, will be increased or decreased proportionally to the increase or 
decrease of equity amount at the beginning of Run 2, and likewise for all follow-up Runs. When set to Constant, 
LotSize at the beginning of each Run (and within the Run if FixedCenter LotSizeIncease settings are not used) will 
remain the same from one Run to the next Run and so on.  
     For example, account equity starts Run 1 at $10000 and LotSize=0.10 and Main_LotSize_Scaling=Proportional 
and CR_ProfitPercent=10 and CR_LossPercent=30. If the CloseRun is positive and reaches its equity increase profit 
target of 10% net of all open and closed trades within the Run (default CR_IncludeClosedTradesNet=true), then Run 
2 start equity will be $11000, and LotSize will automatically be increased to 0.11. If a negative CloseRun then the 
equity is reduced 30% to $7000 and LotSize decreased to 0.07 for Run 2. 
     Whether LotSize_Scaling is Proportional or Constant, it can be automatically increased from grid slot to grid slot 
going out from grid center within a Run by using any of the Grid_FixedCenter_Inputs, either LotSizeIncreaseAmount 
or LotSizeIncreasePercent or LotSizeIncreaseFibo. LotSize cannot be changed on-the-fly.        Settings   
 
18. TakeProfitPips=21 - (TPP) This input determines how many pips profit each of the individual trade orders will 
target. If for example, FGM is trading the EURUSD, and a pending buy trade order opens at 1.3700, and 
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TakeProfitPips=21, then if price reaches 1.3721, the trade will be triggered closed capturing 21 pips of profit (if no 
slippage). When set to 0, this input is ignored. This setting can be changed on-the-fly in MovingCenter Grids, however 
it will affect new pending orders only and not pending orders already in place. 
 
19. StopLossPips=0 - (SLP) This determines the stop-loss set for each individual trade order. If set to the default 0, 
then this input is ignored. If for example, the EURUSD is being traded, and a trade order opens at 1.3700, and 
StopLossPips=50, then if price drops to 1.3650, the trade will be triggered to close at a loss of 50 pips. This setting 
can be changed on-the-fly when trading a MovingCenter Grid and will affect new pending orders only, not pending 
orders already in place.   
 
20. BreakEvenStop=false - (BES) When set to true, a break even stop-loss will be set on each Grid trade order 
according to the values set by the next two settings. When set to false, then the BreakEvenStop settings are disabled.  
Be aware that these settings can work with or without the ProfitPipsBeforeTS settings further below. These settings 
cannot be changed on-the-fly. 
 
21. ProfitPipsBeforeBES=0 - (PPBBES) When BreakEvenStop=true then this setting is enabled. If set to 10 as an 
example, when a pending order is triggered open and then moves 10 pips into profit, then a break even stop is placed 
on the order so that if price retraces by 10 pips, the open trade is closed at break even plus whatever pips value is set 
by the next setting. This value can only be set to whole pips, not fractional pips.        
 
22. BreakEvenStopPlusPips=0 - (BESPP) The value in pips set here adds to the break even stop. If set to 3 pips as 
an example, then it means that if ProfitPipsBeforeBES=10 and an open order reaches its 10 pips profit target and the 
BreakEvenStop is triggered and then price retraces 7 pips (10 - 3), then the order stops out 3 pips in profit. This 
setting is useful to offset commission and or swap fees and or slippage.      Settings 
 
23. ProfitPipsBeforeTS=0 - (PPBTS) If set to the default 0 pips, then this setting is ignored. If set to a value such as 
36 as an example, each of the individual trade orders that are opened will need to move 36 pips into profit before the 
TrailStopPips input setting below is activated. If ProfitPipsBeforeTS=0 then whatever TrailStopPips is set to will be the 
immediate starting trailing stop loss. It differs from StopLossPips which fixes the StopLoss on the broker server. This 
setting cannot be changed on-the-fly.                                                                                                      .  
 
24. TrailStopPips=0 - (TSP) This input determines how many pips the trail-stop will be. As an example, if 
ProfitPipsBeforeTS=0 and TrailStopPips=50, then a stop-loss is immediately set at 50 pips away from where the 
pending order is opened. That stop loss will then trail pip by pip from there if price moves in a profitable direction. If 
price moves in a losing direction then the trailing stop loss will remain fixed where it. For another example, if 
ProfitPipsBeforeTS=36 and TrailStopPips=9, then when each individual order is 36 pips into profit, the trail stop of 9 is 
triggered and 27 pips of profit will be locked in and if price keeps moving in a profitable direction, the trail stop will 
follow pip by pip. Let’s say that an individual order moves 50 pips into profit and then retraces 9 pips. The trade will 
then close out with 41 pips of profit.  
 
25. MaxOrderPeriod=990 - (MOP) This setting’s value determines a period of time in seconds that works with the 
next setting MaxOrderFrequency. If set to the default 0, then this setting and the next setting is ignored. If set to the 
value 990 seconds (16.5 minutes), as an example, then the value set for MaxOrderFrequency is the maximum 
number of trade orders that can be placed within the time period determined by MaxOrderPeriod.             Settings    .                 
.             
26. MaxOrderFrequency=3 - (MOF) If MaxOrderPeriod is set to a higher value than 0 seconds, then this setting is 
activated. If set to a value such as 2, as an example, then it means that no more than 2 trade orders can be opened 
within the time period determined by the previous setting MaxOrderPeriod. These settings are used to counteract 
large price spikes and swings by lessening the number of accumulating trades in the negative. Please note however 
that those 2 trades will be in loss and any other open trades that are in profit during the MaxOrderPeriod will be 
ignored because price is moving against the 2 trades set by MaxOrderFrequency and the open trades in profit are 
moving towards their TakeProfit target. Both of these settings cannot be changed on-the-fly.  
 
 
 
 
 
 
 
 



FGM Express AUDNZD default strategy, 5 profit CloseRuns (yellow vertical bars), Spike protection demonstrated. 
 

 
      
Grid_FixedCenter_Inputs  - modify Grid orders when Main_Grid=Fixed_Center. 
 
When Main_Grid=Moving_Center, the next 5 settings are ignored. If Main_Grid=Fixed_Center, then whatever grid of 
pending orders is initially placed, according to the next 5 settings below (and other settings above and below), that 
grid will remain with a FixedCenter for the duration of the Run and no other pending orders will be placed except 
when any of the pending orders in the FixedGrid slots are triggered open and then eventually closed, either manually 
or automatically, and then replaced (if GridOrderReplacement=true) by pending orders that match exactly the 
parameters that were set originally for the closed orders being replaced (TakeProfitPips, StopLossPips, etc.). This 
replacement of opened and closed grid orders will continue until the Run is closed, either manually by the  trader or 
automatically by any of the CloseRun input settings, CR_ProfitPercent, CR_ProfitPercentBeforeTS with  
 
TrailStopPercent, CR_ProfitMoneyBeforeTS with CR_TrailStopMoney, and or CR_LossPercent or CloseAllNow 
(CloseNow Setting). When a CloseRun occurs and CR_AutoRestart=true, then a new FixedCenter Grid Run will start 
at the immediate current bid price after all previous Run orders are closed. This setting cannot be changed on-the-fly. 
  
27. GridSpacingStep=0.05 - (GPS) When set to the default 0, this input is ignored. When set to a number and 
Main_Grid=Fixed_Center, then the GridSpacing is increased incrementally by that number. The number can be set as 
pips or a pip fraction. For example, if trading a BuySell Grid and GridSpacing=10 and GridSpacingStep=0.2, then the 
distance between the 1st buy and 1st sell slot positions in the Grid will be 10 pips. The next interval between the 1st 
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and 2nd  pending buy orders and the 1st and 2nd sell pending orders will be 10.2 pips, the next 10.4 pips, and so on. 
For either Buy or Sell FullGrids, GridSpacing increases in both directions, for pending orders above and below grid 
center. When a Run closes and a new Run begins automatically (CR_AutoRestart=true), GridSpacing starts again as 
was originally set and pending order intervals are then increased again as was also originally set by GridSpacingStep. 
This setting cannot be changed on-the-fly.      Settings 
 
28. LotSizeIncreaseAmount=0 - (LSIA) When set to the default 0, this input is ignored. When set to a number and 
Main_Grid=Fixed_Center, then the lot-size, as determined by LotSize or LotSizeScaling setting, is increased from one 
pending order slot to the next by that number. For example, if the starting lot size is 0.15 and LotSizeIncrease=0.01, 
then the lotsize for the next pending order placed will be 0.16, the next 0.17, and so on. When a Run is closed (all 
open trades closed and pending orders deleted), a new Run automatically begins when CR_AutoRestart=true, the 
FixedCenter Grid and lot-size starts again as was set originally (either by LotSize and or LotSizeScaling) and the lot-
size is increased again as was also originally set. This setting cannot be changed on-the-fly.  
 
29. LotSizeIncreasePercent=16.2 - (LSIP) When set to the default 0, this input is ignored. When set to a percent and 
Main_Grid=Fixed_Center, then the lot-size (as determined by either LotSize and or LotSizeScaling) is increased 
incrementally from one pending order slot to the next by that percent. This setting may be useful for Martingale 
strategies made famous by professional gamblers. For example, if the starting pending order lot-size is say 1.2 and 
LotSIzeIncreasePercent=100, then the next pending order lot size would be increased by 100% to 2.4, the next one to 
4.8, the next one to 9.6, the next one to 19.2, and so on. If starting with a lot-size of 1.2 and 
LotSIzeIncreasePercent=50, then the next pending order lot-size would be increased by 50% to 1.8, the next one to 
2.7, the next one to 4.05, and so on. When a Run is closed (all open trades closed and pending orders deleted) and a 
new Run begins automatically when CR_AutoRestart=true, the Grid FixedCenter and lot-size starts again as was 
originally set (either by LotSize and or LotSizeScaling) and the lot-size is increased again as was also originally set. 
This setting cannot be changed on-the-fly.      Settings 
 
30. LotSizeIncreaseFibo=false - (LIF) When set to the default false, this input is ignored. When set to a number and 
Main_Grid=Fixed_Center, then lot-size (set by either LotSize and or LotSizeScaling) is increased incrementally from 
one pending order slot to the next in accordance with the Fibonacci sequence ... 0, 1, 1, 2, 3, 5, 8, 13, 21, 34, 55, 89, 
and so on. The sequence grows using the formula … next lot-size = current lot-size + previous lot-size. For example, 
if the starting lot-size is 1.2, then the next lot-size will be 1.2 (1.2 + 0, the previous lot-size), and the next lot-size will 
be 2.4 (1.2 + 1.2), and the next lot-size will be 3.6 (2.4 + 1.2), and the next lot-size will be 6.0 (3.6 + 2.4), and the next 
lot-size will be 9.6, and so on. When a Run is closed (all open trades closed and pending orders deleted) and a new 
Run begins automatically when CR_AutoRestart=true, the Grid FixedCenter and lot-size starts again as was originally 
set (either by LotSize and or LotSizeScaling) and the lot-size is increased again as was also originally set. This 
setting cannot be changed on-the-fly.  
 
31. TakeProfitPipsStep=0.2 - (TPPS) When set to the default 0, this input is ignored. When set to a number and 
Main_Grid=Fixed_Center, then the value set for TakeProfitPips is increased incrementally from one pending order 
slot to the next by the set step number. The number can be set as pips or pip fraction. For example, if 
TakeProfitPips=20 and TakeProfitPipsStep=0.5 and there are 6 FixedCenter slot buy positions created by 
MaxOpenBuyTrades=6, then the buy order at buy slot 1 position (closest to grid center) is set to TPP=20, the buy 
order at buy 2 slot position is set to TPP=20.5, buy 3 to TPP=21, buy 4 to TPP=21.5, buy 5 to OTPP=22 and buy 6 
(furthest from grid center) to TPP=22.5. So not only can the lot-size be increased for grid orders moving out from grid 
center but also their take profit pips which is very helpful for CounterTrend strategies stretched out over a large range 
where retracements are bigger. This setting cannot be changed on-the-fly.         Settings 
 
Grid_MovingCenter_Inputs - apply only to MovingCenter grids (Main_Grid=Moving_Center) 
 
32. BuySellOverlap=false - (BSO) When set to true then Grid buy orders and sell orders can overlap. When 
BuySellOverLap=false then all pending and or open buy orders will remain on one side separated from all sell orders 
on the other side (see examples just below). This setting cannot be changed on-the-fly. 
 
33. BuySellOffsetPips=0 - (BSOP) This input prevents buy and sell orders from occupying the same price slot 
positions when a BuySell strategy is traded using BuySellOverlap. This enables viewing where all the buy and sell 
orders are on the chart. There may be other advantages too according to what strategy is being traded. The number 
of pips that this is set to, determines how many pips sell orders are placed below buy orders in a BuySell grid where 
buys and sells overlap. This does not affect and is different from GridSpacing and CenterZonePips. This setting 
cannot be changed on-the-fly. Here are various samples using EURUSD bid prices ... 
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BuySellOverlap=true 
BuySellOffsetPips=3 
GridSpacing=6 
CenterZonePips=0     
       
------------- 1.37070 
--- Buy --- 1.37060 
------------- 1.37050 
------------- 1.37040 
--- Sell --- 1.37030 
------------- 1.37020 
------------- 1.37010 
--- Buy --- 1.37000 
------------- 1.36990 
------------- 1.36980 
--- Sell --- 1.36970 
------------- 1.36960 
------------- 1.36950 
--- Buy --- 1.36940 
------------- 1.36930 

BuySellOverlap=true 
BuySellOffsetPips=1 
GridSpacing=6 
CenterZonePips=0          
   
------------- 1.37070 
--- Buy --- 1.37060 
--- Sell --- 1.37050 
------------- 1.37040 
------------- 1.37030 
------------- 1.37020 
------------- 1.37010 
--- Buy --- 1.37000 
--- Sell --- 1.36990 
------------- 1.36980 
------------- 1.36970 
------------- 1.36960 
------------- 1.36950 
--- Buy --- 1.36940 
--- Sell --- 1.36930 

BuySellOverlap=false 
BuySellOffsetPips=0                      
GridSpacing=3 
CenterZonePips=6 
         
------------- 1.37070                
--- Buy --- 1.37060 
------------- 1.37050              Settings 
------------- 1.37040 
--- Buy --- 1.37030 
---- CZ---- 1.37020 
---- CZ---- 1.37010 
---- CZ---- 1.37000 
---- CZ---- 1.36990 
---- CZ---- 1.36980 
--- Sell --- 1.36970 
------------- 1.36960 
------------- 1.36950 
--- Sell --- 1.36940 
------------- 1.36930 

 
CloseRun_Inputs - control CloseRuns for Grids and are Stealth Mode Settings not known by the broker.     
 
Grid Runs, Magic at the Core of FGM Express                                    TOC                                  Settings 
 
When ForexGridMaster Express is initiated on a chart, no matter what settings are used, grid Run 1 starts and trade 
orders are placed on the broker’s MT4 server according to those settings and values chosen by Trader. The 
CloseRun settings in this section all determine how and when and if the Grid of orders is completely closed and 
whether the robot will automatically restart trading again with Run 2 and follow-up Runs or not. Partial Run closes are 
possible by closing trades manually or by using input settings in the “CloseNow_Inputs” section, except CloseAllNow 
which does trigger a complete CloseRun. When either complete or partial CloseRuns occur, a coloured vertical bar 
(Vertical Line object) will mark the place on the chart and its properties state CloseRun number, type, time and equity, 
as well as the number of Buys and or Sells closed. Full CloseRuns will be numbered 1, 2, 3 etc. Partial CloseRuns 
add letters to the numbers … 1a, 1b, 1c, etc. The color of the vertical bar among other things can be adjusted in the 
FGM_Express.prf file found in 2 places, (MT4 platform)\MQL4\Files\FGM_Express.prf where changes affect either a 
demo or real money account or (MT4 platform)\tester\files\FGM_Express.prf where changes affect Strategy Tester.        
 
34. CR_AutoRestart=true - (CRAR) If set to the default of true, then FGM will automatically restart a new grid Run 
immediately after the present grid Run is closed due to any of the CloseRun settings in this section that are activated 
and triggered. If set to false, then no new Run will be started after a CloseRun is complete, and FGM must be 
manually reset to start trading again and the Run count starts again at Run 1. This setting can be changed on-the-fly.  
 
35. CR_ProfitPercent=0.0 - (CRPPc) If set to the default 0, then this input is ignored. When set to a percent number 
value, this input determines the percentage of equity profit that will trigger a profit CloseRun which will close all Grid 
open trades and delete all pending orders and then FGM Express will automatically initiate the next Run provided that 
CR_AutoRestart=true. As an example, if CR_ProfitPercent=3, this means that 3% of the Run start equity becomes 
the CloseRun profit target. FGM will then close the current Run when it reaches the 3% profit target and a new Run 
will start immediately. The 3% profit target, if CR_IncludeClosedTradesNet=true, is the Net Profit value of all closed 
trades plus the Net Profit value of all open trades within that specific grid Run. During trading, the constantly updating 
Net Profit Loss figure is seen on the chart in the Current Stats section. This is calculated separate from other EA 
placed trades (FGM or other robots) or manually placed trades running on the same currency pair or other currency 
pairs on the same account. Different unique EA numbers must be used if more than one EA is used on the same 
currency pair, or on other currency pairs in the same account. This setting can be changed on-the-fly. 
 
36. CR_LossPercent=70 - (CRLPc) If set to 0, then this input is ignored. This input triggers a loss CloseRun when 
the net of all open and closed trades combined within the Run is negative by whatever percent of high water mark 
account equity (or ChartEquity if set) this input is set to, 70% in this case. When CRLPc is triggered it will close all 
Grid open trades and delete all pending orders and then FGM Express will automatically initiate the next Run 
provided that CR_AutoRestart=true. This setting can be changed on-the-fly.       Settings 
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0. CR_LossPips=0 - (CRLP) If set to default 0 then this input is ignored. This input closes the Run when the net 

1. CR_ProfitMoneyBeforeTS=0 - (CRPMBTS) When the above CR_ProfitPercent input is set to a percent amount, 

2. CR_TrailStopMoney=0 - (CRTSM) When the above CR_ProfitMoneyBeforeTS input is set to the default 0, this 

3. CR_PriceMaximum=0 - (CRPMax) If set to default 0 then this input is ignored. If set to a bid price then when 

4. CR_PriceMinimum=0 - (CRPMin)  If set to default 0 then this input is ignored. If set to a bid price then when price 

5. CR_PriceTrailStopPips=0 - (CRTSP) If set to default 0 pips, then this setting is ignored. If set to a value of 1 or 

37. CR_ProfitPercentBeforeTS=0.3 - (CRPPcBTS) If CR_ProfitPercent=0 then CR_ProfitPercentBeforeTS will be 
enabled when set to a percent amount or ignored if set to the default 0. If CR_ProfitPercentBeforeTS=1.1 as an 
example, then equity must increase by 1.1% before the CR_TrailStopPercent input below is triggered. The 
ProfitPercent target if CR_IncludeClosedTradesNet=true equals the Net Profit total of trades closed during that 
specific grid Run plus the net profit total value of all open trades. This setting can be changed on-the-fly.  
 
38. CR_TrailStopPercent=0.0001 - (CRTSPc) When CRPPcBTS above is set to default 0, this input is ignored. 
When set to percent value, this input is enabled. If CR_TrailStopPercent=0.1, and CR_ProfitPercentBeforeTS=1.1 is 
reached, a 0.1% trail stop is activated and 1 % profit is locked in. When the 1.1% profit target is reached and profit 
increases from there, then the trail stop trails by 0.1%. This setting can be changed on-the-fly.  
 
39. CR_ProfitPips=0 - (CRPP) Set to default 0 this input is ignored. Set to a pips number value (whole pips only, no 
fractions), this input determines what number of pips in profit will close a CloseRun (close all Grid open trades and 
delete all pending orders). As an example, if trader sets CR_ProfitPips=150, this means that 150 pips becomes the 
Run target. ForexGridMaster will then close the present Run when it reaches the 150 pips in profit target and a new 
Run will start immediately (unless CR_AutoRestart=false). The 150 pips target is the Net Profit total of Grid closed 
trades within that specific grid Run plus the net value of all open trades, except if CR_IncludeClosedTradesNet=false, 
in which case only the open trades are considered. If ShowComments=true then the constantly updating Net Profit 
Pips figure on the chart in the Current Stats section can be viewed. This setting can be changed on-the-fly.        
4
total pips of all Grid open and closed trades within the Run, is negative by whatever high water mark number of pips 
this input is set to. However, the exception is if CR_IncludeClosedTradesNet=false, in which case only the open 
trades are considered. That number of pips is based on the highest number of pips attained from the time 
ForexGridMaster opens its first trade for that Run. This is calculated separate from other grids or trades placed 
manually, running on the same currency pair. Different unique EA numbers must be used for more than one EA 
trading on the same currency pair or any other pairs in the same account. This setting can be changed on-the-fly.  
 
4
this input and the CR_TrailStopMoney input below is ignored. If CR_ProfitPercent=0 then this setting can be enabled 
when set to a money amount or ignored if left at the default 0. If CR_ProfitMoneyBeforeTS=3000 for example, then 
equity must increase by $3000 before the CR_TrailStopMoney input below is enabled (or whatever base currency the 
account uses). The ProfitMoney target is the Net Profit money total of all Grid open and closed trades within that 
specific grid Run. This setting can be changed on-the-fly.         Settings 
 
4
input is ignored. When the above CR_ProfitMoneyBeforeTS input is set to a money number, such as 3000, then this 
input is enabled. If this input is set to say 500, then when profit reaches $3000, the $500 trail-stop is activated and a 
$2500 profit is locked in. As profit increases, the trail-stop will trail dollar by dollar (or whatever base currency the 
account uses), if to $3001 then $2501 profit is locked in, if to $3760 then $3260 profit is locked in. The ProfitMoney 
target is the Net Profit total money of all Grid open and closed trades within that specific grid Run. This setting can be 
changed on-the-fly. 
 
4
price rises to that set bid price, then FGM shuts down, closing all Grid open trades and deleting all pending orders. 
and no new Run will be started, and ForexGridMaster must be manually reset to start trading again and the Run 
count starts at 1 again. This setting can be changed on-the-fly. 
 
4
drops to that set bid price, then FGM shuts down, closing all Grid open trades and deleting all pending orders. and no 
new Run will be started, and ForexGridMaster must be manually reset to start trading again and the Run count starts 
at 1 again. This setting can be changed on-the-fly. 
 
4
more, then this setting applies to the current bid price at the time of its initiation. If as an example the current 
EURUSD price is 1.3095 and CR_PriceTrailStopPips=20 (plus 20) then as price moves up, the stop-loss will trail by 
20 pips from below price but will not retrace back down. Whenever price retraces back down by 20 pips then a 
CloseAllNow is triggered and the current grid Run will be stopped on the next tick and all orders controlled by that EA 
will close. Open trades are closed and pending orders deleted and FGM Express is completely stopped. FGM must 
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en be removed and restarted again manually. If current EURUSD price = 1.3095 and CR_PriceTrailStopPips=-20 

6. CR_LossStop=true - (CRLS) When set to the default true then any further trading activity is prevented once the 

7  CR_IncludeClosedTradesNet=true - (CRICTN) This is a switch for CloseRun Net Profit Loss calculations that 

lose_Now_Inputs  - These settings are used to immediately close some or all trade orders controlled by this 

               

8. CloseOrdersNow=None (CON) (or Close_Buy_Orders (CBO) or Close_Sell_Orders (CSO) or                         . 

               

               

               

GM_Express.prf to Edit More Settings, Alerts, Objects, Chart Display                      TOC                         .                 

he FGM_Express.prf file is in the MT4 platform active data folder in the “\MQL4\Files” and “\tester\files” directories 

            

estCommission             = 0.00             

 

number of buys) 

th
(minus 20) then the same event will occur but in the opposite direction... the CR_PriceTrailStopPips follows price 
down from above price. Say price goes down from 1.3095 to 1.3007 without retracing 20 pips along the way and then 
price retraces 20 pips back to 1.3027, then the CloseAllNow function is triggered. Please be careful when using 
CR_PriceTrailStopPips and CR_AutoRestart. This setting can be changed on-the-fly.       Settings                             . 
 
4
Run is closed by CR_LossPercent or other loss choices above. This setting can be changed on-the-fly.  
 
4
trigger CloseRuns. When set to true, the Net Profit Loss value of all closed trades within a Run is included with and 
added to the Net Profit Loss value of all open trades within the Run and their combined value will trigger a CloseRun 
according to CloseRun profit or loss settings. When CR_IncludeClosedTradesNet=false, it means that calculations of 
Net Profit Loss that trigger a CloseRun only apply to open trades, and not to any closed trades within the Run.        
 
C
instance of FGM and its EANumber. Once closed, the settings need to be reset for FGM to resume trading. Trader is 
reminded by popup, comments message and log entry. As an alternative, use ForexTradeManager to close all orders 
of all EAs and any manually placed orders, either immediately or according to choice of several settings.                  .  
 
4
Delete_Pending_Buys (DPB) or Delete_Pending_Sells (DPs) or Close_Profit_Orders (CPO) or     . 
Close_Loss_Orders (CLO) or Close_All_Now (CAN))  - When CloseOrdersNow=None this setting is ignored.  
     When set to Close_Buy_Orders or Close_Sell_Orders and OK is clicked to trigger the closes, either all open buy 
or all open sell trades will be closed, which is a partial CloseRun and going back to the FGM inputs is needed to reset 
CloseOrdersNow=None and to click OK to allow FGM to continue control of the Run and the appropriate pending 
orders will replace the closed trades when price returns to those Grid slot positions.         Settings                                .  
     When set to Delete_Pending_Buys or Delete_Pending_Sells, all pending buy orders or all pending sell orders will 
be deleted, which is a partial CloseRun and going back to the FGM inputs is needed to reset  CloseOrdersNow=None 
and click OK to allow FGM to continue control of the Run and the appropriate pending orders will replace the closed 
pending orders appropriately.                                                                                                                            .  
     When set to Close_Profit_Orders or Close_Loss_Orders all orders in Profit or all orders in Loss will be closed, 
which is a partial CloseRun and going back to the FGM inputs is needed to reset to CloseOrdersNow=None and click 
OK to allow FGM to continue control of the Run and the appropriate pending orders will replace the closed trades 
when price returns to those Grid slot positions.                                                                                    .  
     When set to Close_All_Now, all trade orders, open and pending will be closed, which is a full CloseRun, and to 
restart FGM trading again, reset to CloseOrdersNow=None for FGM to continue.                                   . . 
     When a partial CloseRun occurs, FGM Express continues to keep track of the net value total of all trades closed 
(provided CR_IncludeClosedTradesNet=true) plus the net value total of all open trades during the Run, until the open 
and closed trades combined net value triggers a CloseRun. This setting can be changed on-the-fly.                             . 
     The above settings really need to be practised well to understand what they do and what they can do. They can be 
good choices to use with scalping strategies.                                                             .  
 
F
 
T
which is found by going to Top menu > File > Open Data Folder. FGM can be traded with the FGM_Express.prf file as 
is using its default values, but there are many settings in there (see below) that can be customized to suit 
preferences. When editing and saving the settings, changing any of those settings will not have to be done again 
when creating a new strategy or trading someone else’s or changing to trading a new account on the same platform. 
It’s a great time saver. To edit the file, right-click the file name and choose Edit. Notepad or any text editor can be 
used. As an example, on a live real account or demo, I trade on charts with a white background and use the 
\MQL4\Files\FGM_Express.prf file settings customized as follows …                                     .                                            
 
T
AlertRunClosedSound      = true; 
AlertRunClosedPopup       = false;
AlertRunClosedEmail        = false; 
AlertBuysOpenSound      = 0;  (set 
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 (set number of sells) 

 
ue;                                                                  Settings 

 

 
  

ridMaster.com";  (back-test disconnected from the broker) 

ck;    

av;    (sounds for all of these can be customized) 

 Specify colors as web-color names (e.g. clrMediumBlue) or in hex-format (e.g. 0xBBGGRR)           Settings 

   (CloseBars happen at CloseRuns.)                                   

 

here is a second FGM_Advanced.prf file in “\tester\files” used for back-testing in Strategy Tester.  

AlertBuysOpenPopup      = 0;                    
AlertBuysOpenEmail       = 0; 
AlertSellsOpenSound       = 0; 
AlertSellsOpenPopup         = 0; 
AlertSellsOpenEmail            = 0;
AlertMarginWarningSound      = tr
AlertMarginWarningPopup        = false; 
AlertMarginWarningEmail            = false;
AlertFgmStoppedMinutesSound     = 0; 
AlertFgmStoppedMinutesPopup      = 0; 
AlertFgmStoppedMinutesEmail         = 0;
AlertHedgeOrderOpenBuysSound      = 0;
AlertHedgeOrderOpenBuysPopup      = 0;  
AlertHedgeOrderOpenBuysEmail       = 0;  
AlertHedgeOrderOpenSellsSound    = 0;  
AlertHedgeOrderOpenSellsPopup    = 0;  
AlertHedgeOrderOpenSellsEmail     = 0;  
LogActivity                                      = true; 
LogDebugInfo                             = default  
AfterMarginLimitResume           = true; 
AccountNameTester                = "ForexG
ShowMaxEquityDrawdown      = true; 
ShowBuySellMarkers             = true;  
ShowComments                  = true; 
TextSize                             = 10; 
TextColor                           = clrBla
ChartBackgroundDark       = false; 
SoundCloseRun               = alert2.w
SoundInputError              = expert.wav; 
SoundBuysOpen             = alert.wav; 
SoundSellsOpen             = alert.wav; 
SoundMarginWarning     = alert.wav; 
SoundFgmStopped         = alert.wav; 
 
//
CenterLineColor              = clrSteelBlue; 
TrailPriceColor                 = default; 
OpenBuyMarkerColor      = default; 
OpenSellMarkerColor      = default 
CloseBarInitialColor        = clrRed;  
CloseBarPartialColor      = clrLightYellow; 
CloseBarFullColor          = clrYellow; 
CloseBarBackColor        = clrOrange;
 
T



FGM Express Comments Displayed on Chart                   TOC                  Settings                                     . 
 

 
 
Explanation of FGM Express comments in AUDNZD M1 chart above …  
 
1. Set file = info entered in SetFileName input setting, whatever useful, usually main settings and values..  
2. Set info = more space to add whatever info desired to display in the ForexGridMaster comments on the chart. 
3. Account Equity = current trading account equity / Chart Equity = current equity for chart only (see ChartEquity). 
4. Run 1 Start Equity = (money) on (date) at (time) … self explanatory. 
5. Run 1 to Run (number)  Net Profit (money) or (percent) … useful for analysis (compounding, etc). 
6. Run (number)  Start Equity = (money) on (date) at (time) … self explanatory. 
7. Current Run Net Profit = (money) and (percent) … tracked live tick by tick  
8. Drawdown = (percent) and (money) on (date) at (time) … maximum floating equity drawdown during all Runs. 
9. Min Chart Equity = (money) / Min Margin Level = (percent) … important to track, too low means too risky. 
10. ProfitPercentBTS = (percent) and TrailStop = (percent)  … determined by CloseRun settings. 
11. Loss Limit (money) and (percent) … determined by Input values set in the CloseRun settings. 
12. MainGrid Buys: (number), Lots (number) / Sells (number), Lots (number) … open trades and total volume.Settings 
 
FGM Problem Solving and Reporting Errors Plus                             TOC                             Settings 
 
If ForexGridMaster is not doing what it is supposed to do, then it's time to put on a detective hat. If the strategy has 
already been initiated on the chart then open the ForexGridMaster EA property window and check the input settings 
thoroughly to make sure they are properly configured and also compatible with each other. The more familiar trader is 
with the manuals and all the workings of the ForexGridMaster input settings the better.   
 
Always look for error messages mostly in the "Experts" tab and sometimes in the “Journal” tab, both of which can be 
accessed at the bottom of the Terminal window which by default is along the bottom of the MT4 platform window. A 
new log file is created each day. The most recent day entries can be viewed, selected and copy pasted direct from 
the tab entries list. To get to the whole log file for that particular day or for any other day, right click any line entry on 
the "Experts" and “Journal” tab and then choose “Open” and the pop-up window will display a list of log files. Open a 
log file to see all the entries for that day. Select the appropriate entries from the log file (usually the best method) and 
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copy paste them into an email to support@forexgridmaster.com as part of a problem report if our help is needed.  
Also go to our forum for help with strategies.          Settings 
 
Sometimes starting again from scratch is all that is needed. Follow these steps … 
 
1.  Close out all open and pending trade orders, either manually or use CloseAllNow at bottom of FGM Inputs.  
2.  Remove FGM. Right click on the chart in a clear area > Expert Advisors > Remove.  
3.  Delete all Global Variables. Go to top menu > Tools > Global Variables > Select all > Delete. 
3.  Delete all Objects from the chart. Right click on chart > Objects List > Select all > Delete. 
4.  Close the MT4 platform. Best to go to top menu > File > Exit so that the platform can re-open as it was. 
5.  Go to the MT4 active Data Folder \logs and \MQL4\Logs and delete all log files (after extracting any info needed). 
6.  Restart the MT4 platform. 
7.  Load FGM on the chart (drag and drop FGM the Navigator window or select chart and double click FGM, 
8.  Configure the settings wanted in the FGM properties window Inputs tab. Consult the manual for settings info. 
9.  Click Save, name and save the preset file wherever, usually the default directory … \MQL4\Presets. 
10.  Click OK to start FGM trading. 
11.  If FGM does not operate as desired, then please send to support@forexgridmaster.com  … 
12.  The preset file from the MT4 active Data Folder \MQL4\Presets\(whatever it is named).set 
13. Send us the experts log file from the MT4 active Data Folder \MQL4\logs\20130311.log (whatever date it is). 
14. If the problem is displayed on the chart, go to top menu > File > Save as Picture… > Active Chart (as is) 
15. Tell us what happened  and also provide the appropriate info requested in the list below.  
  
The above procedure solves 99% of the problems. The other 1% would be a corrupted MT4 program (not because of 
FGM) which is usually fixed by a re-install of the MT4 platform.             Settings 
 
Please provide some or all of the following information when reporting to support@forexgridmaster.com … 
 

 Broker: 
 Micro, Mini or Standard account: 
 Account Leverage (100:1, 200:1, 500:1, etc.): 
 Acct Balance and Equity and Margin level, ChartEquity if used: 
 MT4 Platform build from "Help" in the top menu and then "About..." on the left: 
 When loading FGM on the chart does it show a smiley face: 
 What time-frame is FGM trading: 
 Are there other instances of FGM or other EAs trading on the same platform? manual trades? If so explain. 
 Attach the preset “.set” file/s which can be most important as it enables us to precisely recreate the problem 

and work on it directly and it saves us all a lot of time. 
 Attach Experts and Journal log files or copy paste appropriate entries into the email. It is best to set 

LogActivity=true and LogDebugInfo=true and send us those log files when the problem occurs. Go to the 
Experts and Journal tab at the bottom of the Terminal window and right click on an entry and choose “Open” 
to view the whole log file for that day or any previous days, and then save that log file to the desktop or 
somewhere and then attach them to an email to us and we will figure it out. 

 If appropriate, send a copy of the Account Statement accessed from the “History” tab at the bottom of the 
Terminal window. Right click in the History entries, choose period of report and then choose “Save as 
Detailed Report” and save to desktop or wherever it can be found. 

 If appropriate, send the chart image using the EA. Go to the top menu… “File”, then “Save As Picture…” 
 Please be thorough and include whatever other information that may be helpful. 

 
Ideas and strategy contributions are most welcome. If there are any new inputs suggested that can make 
ForexGridMaster even better and we agree, then we will add that feature, or we can customize it for individuals at a 
price. We will continue to fine tune ForexGridMaster and keep up with any newer builds of MT4 that come out, so that 
it will always be as stable and reliable as possible. FGMers will immediately be informed and have access to any 
upgrades. Questions, comments, and suggestions are welcome regarding this manual and ForexGridMaster trading 
in general. We always want to continuously improve this manual, our robots and our interaction with other traders.        
 
Sincerely, James King and Team 
Trading Forex full-time since 2002,  
ForexGridMaster Developer since 2005   
                                                  

mailto:support@forexgridmaster.com
http://forexgridmaster.com/fgm-forum/phpBB3/index.php
mailto:support@forexgridmaster.com
mailto:support@forexgridmaster.com
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MT4 active data folder (Top menu > File > Open Data Folder)                              TOC                      Settings 
   MQL4 (directory) 
    - Experts (directory) 
          FGM_Express.ex4 
          ForexTradeManager.v1.10.ex4    
    - Files (directory) 
          FGM_Express.prf (edit for demo and real money trading)      
    - Libraries (directory) 
          eafocs.dll 
          fgm_normalize.ex4 
          FGM53.dll 
          fw_adaptor.ex4 
  templates (directory) 
       wb_20-60-120-240-720-3600-sma.tpl 
       wb_grid-basic.tpl 
  tester (directory) 
     - files (directory) 
          FGM_Express.prf (edit for “Visual mode” display in Strategy Tester) 
 
ALL TRADING INVOLVES RISK OF LOSS - Trading in the Off Exchange Retail Foreign Currency Market (FOREX) 
can be one of the riskiest forms of investment available in the financial markets due to the ability to trade at high 
leverage (500 to 1 with some brokers) and therefore is suitable mostly for sophisticated individuals and institutions. 
The possibility exists that you could sustain a substantial or complete loss of funds and therefore you should not 
invest money that you cannot afford to lose. Nothing in this presentation is a recommendation to buy or sell  
currencies and James King or ForexGridMaster.com is not liable for any loss or damage, including without limitation, 
any loss of profit or funds invested, which may arise directly or indirectly from the use of James King’s or 
ForexGridMaster.com's products such as, but not limited to… trading robots, tools, information, etc. or reliance on 
such information. Past performance does not guarantee future results and this refers also to all past performance 
demonstrated on ForexGridMaster.com. Every investor should consider all advice and all offerings of products and 
services on their own merits and for suitability to the investor's personal needs and circumstances.                          .  
 
“Risk comes from not knowing what you are doing!” - Warren Buffet                        TOC                     Settings 
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